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Product Overview 
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The storage function of RAID is used to introduce on industrial field which means With expensive and  
expert maintain needed. For the personal computer and small office or home office field, Such a  
requiring just never satisfied but with the Data Marshalling This is just a part of its all. 
 
 
The BT-3045 Data Marshalling System is a cost-effective and ready-to-use storage appliance powered  
by Silicon Image's industry-leading storage processor, providing enhanced data protection, 
high-performance storage, and plug-and-play functionality. The BT-3045 Data Marshalling System is a 
simple and affordable solution for SOHO or personal users to replicate data and keep data secure. 
Volumes can be created with mirrored drives providing automated data protection along with 
notifications when a drive needs replacement. 
 
 
The BT-3045 Data Marshalling System has preconfigured setups so that you don't need any 
experience on storage network administrator or prior knowledge of physical disk drives to configure 
the System. Meanwhile, being an experienced user, you may also configure BT-3045 manually to suit 
your best need. You can always use BT-3045 Controller Configuration Utility to monitor or reconfigure 
the Data Marshalling System. The guided configuration utility helps you set up and maintain the best 
possible configuration. You can configure the multi-functional BT-3045 Data Marshalling System to 
support standard business applications such as Microsoft   Exchange Server or SQL database with 
separate mirrored volumes for log files and databases. 
 
 
For demanding performance applications such as video/audio editing, digital imaging, sophisticated 
data processing or just the fastest gaming platform in town, the BT-3045 Data Marshalling System can 
be preconfigured as a striped disk array, simultaneously accessing two or four drives for blazing disk  
performance. 
 
 
The BT-3045 Data Marshalling System adopts Silicon Image's industry-leading Serial Advanced 
Technology Attachment (SATA) which supersedes the Parallel, Ultra ATA/100 interface, improving the 
performance from 100 MB/sec to a data transfer rate of 150 MB/sec with SATA Gen1 and 300 MB/sec 
with SATA Gen2. Populated with five SATA drives, the BT-3045 Data Marshalling System stores as 
much as 2 terabytes of data. And with the next-generation SATA II technology, the BT-3045 Data 
Marshalling System grants 3 GB/sec SATA II capability and provides even more new features such as 
native command queuing and hot plugging. 
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BT-3045 storage policies 
 

The BT-3045 Data Marshalling System provides the following storage policies, for mapping physical 
to virtual drives. You can use the Basic Configuration Wizard or the Advanced Configuration Wizard 
to choose from these policies. It is important to choose an adequate policy to make the best use of 
your Storage Appliance. 
         

This storage policy grants the host computer direct access to a physical disk 
drive. With JBOD (just a bunch of disks), the number of available virtual drives is 
equal to the number of physical drives. JBOD is also called the bypass mode 
because the host bypasses the virtualization engine to access the drive directly. 

JBOD   
 
 
 
 

This storage policy makes all data stored in duplicate on separate hard disk drives 
to prevent data loss due to drive failure. At least two hard disk drives mirror each 
other at all times, equivalent to RAID 1. Every write operation goes to both drives. 
SAFE provides the highest level of data protection, but halves the amount of 
storage space because all data must be stored twice. 
 

SAFE 
 
 
 
 
 

To implement the SAFE storage policy, the Basic Configuration Wizard creates 
two volumes. Each volume consists of two hard disk drives that mirror each other. 
The remaining hard disk drive is specified as a Hot Spare for both volumes. 

 
 
 
 

This storage policy makes multiple physical hard disk drives strung together 
(concatenated) and treated as one large volume. This configuration allows you to 
increase logical volume size beyond the capacity of individual hard disk drives. 
BIG provides the maximum amount of storage space, but no additional 
performance of data redundancy. 
 

BIG 
 
 
 
 
 

The Basic Configuration Wizard implements the BIG storage policy by 
concatenating all the hard disk drives into a single volume. 

 
 
 

In FAST storage policy, the I/O processing is balanced evenly to all drives in a 
method known as striping, equivalent to RAID 0. Striping increases storage 
operation speed by using several disk drives in parallel. Each portion of data is 
divided into segments that are written to different disks simultaneously. Striping 
provides improved performance but does not enhance reliability because there is 
no way to retrieve or reconstruct data stored on a failed drive. 
 

FAST 
 
 
 
 
 
 

To implement the FAST storage policy, the Basic Configuration Wizard creates a 
single volume of four hard disk drives in a striped format. The remaining hard disk 
drive is designated as a standalone volume using the BIG storage policy. 

 
 
 
 
FAFE and BIG A storage policy in which one-half of the available storage space is concatenated. 

The other half mirrors the first half to provide full data redundancy. 
In the SAFE and BIG storage policy, the Basic Configuration Wizard mirrors the  

 
 
 concatenated disks to create a volume consisting of four disk drives and 

designates the remaining hard disk drive as a Hot Spare  
 

A storage policy in which an array of stripes is created. Each strip consists of two 
mirrored drives. SAFE and FAST provide the I/O load balancing features of 
striping and the added reliability of mirrored data, equivalent to RAID 1+0. Data are 
written to mirrored disks in a striped format. 
 

FAFE and FAST 

In the SAFE and FAST storage policy, data are written to mirrored disks in astriped 
format. The Basic Configuration Wizard creates a virtual drive consisting of four 
hard disk drives and designates the remaining drive as a Hot Spare 
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. 
         

One or more hard disk drives are unused during normal operation and are 
configured to be a spare. If an active drive in a SAFE volume fails, the data on the 
remaining hard disk drive is duplicated onto the Hot Spare to regain redundancy. 
All SAFE volumes can have a designated Hot Spare (SAVE, SAVE and FAST, and 
SAFE and BIG). 

A virtual or logical drive comprised of one or more physical hard disk drives. Once 
you create a volume, the operation system uses and maintains the volume as if it 
were a single physical disk drive. This allows software to overcome size 
restrictions imposed by physical disk drives. 

Component of the BT-3045 Controller Configuration Utility responsible for status 
tracking and SAFE volume rebuilds. 

 

 

 

Hot Spare   
 
 
 
 
 
Volume 
 
 
 
 
Daemon 
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The BT-3045 installation has the following hardware and software prerequisites for the host 
computer(s) that will be connected to the BT-3045 Storage Appliances. 
 
 
Hardware 
 

● For x86 platforms:  An Intel PIII 500MHz equivalent or faster 
● For Mac platforms:  A Mac G4 500MHz or faster 
● CD-ROM drive 
● 64 MB of RAM minimum 
● 250 MB of free hard disk space 
● Super VGA (800 x 600) or higher resolution with 256 colors 
● Mouse or compatible pointing device 
● External SATA cable connection between the BT-3045 Storage Appliance and the host 

computer 
 

Software 
 

● For x86 platforms: Microsoft Windows 2000, Windows XP, or Windows Server 2003 with 
the latest Service Pack installed.  

● For Mac platforms: Mac OS X with the latest set of patches installed. 
● BT-3045 CD 



 
 
Hardware installation 
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Before running the BT-3045 Data Marshalling System, it is required that you install a host controller  
(card and driver). The host controller provides a software and hardware link between the host 
computer and the BT-3045 Data Marshalling System. 
 
If your motherboard does not have a build-in Silicon Image SiI 4726 compatible host controller, you 
will need to install one on PCI-X or PCI slot. It is suggested that you use the following Silicon Image's 
controllers which provide port multiplier support: 
 

● SiI3124-2 
● SiI3124-4 
● SiI3132 

 
You may also use another host controller with port multiplier support. However, it is not guaranteed 
that all host controllers with port multiplier support are compatible with the System. 
 
The BT-3045 User's Guide assumes that you are using the BT-90010208A(SATA2.0 1+1 PCI-E Card) 
host bus adapter and driver, which provide port multiplier support as a SATA bost. 
 
Install the host controller card and driver 
 
1. Turn off the host computer. 
2. Install the controller card into a PCI-X or PCI-E slot. 
3. Insert the driver CD into the CD-ROM drive. 
4. If your BT-3045 including a host card. Click the PCI-X host and install the driver. If not please refer 

to the controller card installation Guide of your own. 
 
Connect the host to the BT-3045 Data Marshalling System 
 
The BT-3045 Data Marshalling System houses five configurable hard disk drives. After installing the 
controller card and associated driver, connect the host computer to the BT-3045 Data Marshalling 
System. Then take a moment to verify that the host computer detects the BT-3045 hard disk drives. 
 
Software Operation 
 
The BT-3045 Data Marshalling System bundled with Silicon Image's SiI 4726 as its storage processor. 
For details ofthe software operation, please refer to the SiI 4726 GUI (Graphic User Interface) and its 
User's Guide as follwing pages. 
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This chapter explains how to start the SiI 4726 Manager and describes the Status window. 

Start the SiI 4726 Manager 
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The SiI 4726 Manager starts with the Status window visible so the end-user can monitor the SiI 4726 
StorageAppliances connected to the host com puter. Access the Basic Configuration Wizard from the 
Status window.From there, the end-user can optionally use the Advanced Configuration Wizard to 
create multiple volumes (virtual drives) on each hard disk drive. 
 
 
Start the SiI 4726 Manager 
 
MS Windows 
 
1. Select the Start > All Programs > SiI 4726 > SiI 4726 Manager icon to start the Manager. 

 
 
 
2. Monitor the status of SiI 4726 Storage Appliances on the Status window. 
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3. Select menu options or click toolbar buttons and follow the instructions in the remainder of this 
guide to configure SiI 4726 Storage Appliances. When prompted, enter the administrative password. 
The default password is admin. The end-user can customize the password. See "hange password" for 
details. 

 
 
Mac OS X  
 
1. Launch the Finder and locate the SiI 4726  program within the Applications > Utilities > SteelVine 

folder. Click the folder. Click the SiI 4726 icon to start the SiI 4726 Manager. 

    
 
2. If the launch sequence does not find an active daemon, a warning appears. Click OK. 

 
 
3. Enter the administrator password and click OK. 
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4.  A notice appears as the launch sequence attempts to start the daemon. Click OK. 

   
If the daemon fails to start, an error appears. Follow the recommendations in the error message to 
correct the problem. 
 
5. Monitor the status of SiI 4726 Storage Appliances on the Status window.  

  
 
6. Select menu options or click toolbar buttons and follow the instructions in the remainder of this 

guide  to configure SiI 4726 Storage Appliances. When prompted, enterthe administrative 
password. The default password is admin. You end-user can customize your password. See 
"Change password" for details. 

 

 



 
A Look at the SiI 4726 Status Window 
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The Status window displays a separate tab for each SiI 4726 Storage Appliance attached to the host 
computer. 

 
 
Table 1 Sections of the Status Window 

Status Cells Description 

System Status section 

Temp Indicates the current temperature of the Sil 4726 Storage Appliance. 

Fan Speed Indicates the system fan status. Use this data to monitor possible malfunctions. 

Drive Status section 

Box Status Shows the drive status: Normal, Rebuilding, Unplugged, Needs Rebuild, New 
Drive, Wrong Slot. 

Drive S/N Shows the unique serial number assigned by the disk manufacturer. 

Exp. S/N 
Shows the expected serial number of the hard disk drive. The daemon compares
the Expected and actual Drive serial numbers to detect when a drive's status 
changes. 

Capacity Information section 

Policy Shows the storage policy configured for each vollume. 

Total Shows the combined capacity of the volume. 

Drive # Shows capacity information for each hard disk drive. 

Capacity Shows the full amount of storage space (in GB) available on each hard disk drive.

Volume Shows the total volume capacity and the drive capacities assigned to each 
volume. 
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Table 2 File Menu on the Status Window 

File Menu Item Description 

Change Password Opens a dialog to establish a new password. 

Scan Devices Refreshes the status details presented on the Status window. 

Change Connections Opens a dialog to make remote connections. 

 
Table 3 Edit Menu on the Status Window 

File Menu Item Description 

Configure Box Opens the Basic Configuration Wizard. From there, the end-user 
can access the Advanced Configuration Wizard. 

Specify Policy Opens the Reduild Policy Dialog. 

Specify Email Notification Sends email notification for the selected items. 

Event Log Opens the Event Log viewer. 

Specify Firmware Opens the Firmware Selection dialog. 

 
Table 4 Toolbar on the Status Window 

Button Tooltip Description 

 Configure Box 
Opens the Basic Configuration Wizard. From 
there, the end-user can access the Advanced 
Configuration Wizard. 

 
Specify Policy Information Opens the Rebuild Policy dialog. 

 Email Notification Sends email notification for the selected items. 

 Show Event Log Opens the Event Log viewer. 

 
Specify Firmware Opens the Firmware Selection dialog. 
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This chapter describes the Basic Configuration Wizard and explains how to configure volumes 
(virtual drives). 
 
A Look at the Basic Configuration Wizard 

 
 

4 

The SiI 4726 Basic Configuration Wizard is accessible from the Status window and allows volume 
management.  The Basic Configuration Wizard defines volumes based on a selected storage policy. 
 An end-user cannot modify volume counts or capacities. To protect against unintended changes, the  
SiI 4726 Manager prompts for a password for first time access of the Wizard. The default password is 
admin. (See “Change Password” for additional information on password management.) 
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Table 5 Sections of the Basic Configuration Wizard 

Wizard 
Section Description 

Storage Policy Identifies available storage policies to assign to the SiI 4726 configuration.

Volume List 
Shows Volume, Mode (storage policy), and Size details for created volumes. 
The Total GB s Left  field (beneath the volume list) shows the remaining 
capacity in gigabytes for all the hard disk drives. 

Drive Graph 

Displays disk space for each hard disk drive. All space allocated to the 
same volume appears in a matching color. A hatch pattern indicates a 
proposed configuration and a solid block indicates an existing volume. 
The Cap field beneath each drive in the drive graph shows the maximum 
capacity in gigabytes for that hard disk drive. 

 
Table 6 Toolbar on the Basic Configuration Wizard 

Button Tooltip Description 

 
Read a configuration from
a file 

Reads a saved configuration so the end-user can apply 
the configuration to the SiI 4726 Storage Appliance 

 
Write configuration from 
system to a file  Saves a configuration  to a file on the host computer. 

 
Restore configuration to 
last commit Cancels proposed changes. 

 
Table 7 Command Buttons on the Basic Configuration Wizard 

Button Label Description 

To Advanced 
Mode Opens the Advanced Configuration Wizard. 

Apply Submits configuration changes to the SiI 4726 Storage Appliance and 
closes theConfiguration Wizard. 

Cancel Aborts the changes and closes the Configuration Wizard. 
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Configure Volumes 

 
 
Before running the BT-3045 Data Marshalling System, it is required that you install a host controller  
(card and driver). The host controller provides a software and hardware link between the host 
computer and the BT-3045 Data Marshalling System. 
  
 
1. Select Configure Box from the Edit menu or click the Configure Box toolbar button to open the 

Configuration Wizard. 

    
 
2. When prompted, enter the administrator password. The default password is admin. 
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3. Select a storage policy in the Storage Policy Frame. 

    
 
Table 8 Basic Storage Policy Options 
      

Storage Policy Description 

JBOD (bypass) Creates a logical volume for each physical hard disk drive. 

SAFE (RAID 1) 
Creates two volumes. For each volume, one hard disk drive is 
mirrored onto a second drive. Makes the remaining drive the Hot 
Spare for both volumes. 

BIG (span) Concatenates all hard disk drives into a single volume. 

FAST (RAID 0) Opens the Event Log viewer. 

SAFE and BIG 
Concatenates half the available space on four hard disk drives 
and mirrors that half to the second half of the available space. 
Makes the remaining drive the Hot Spare. 

SAFE and FAST  
(RAID 1+0) 

Creates one volume consisting of four hard disk drives (data is 
written to the mirrored disks in a striped format). Makes the 
remaining drive the Hot Spare. 
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4. When prompted to acknowledge that the configuration change may result in data loss, click Yes to 

accept the configuration. 

    
 
5. Select Save to Config File from the File menu or click the Write configuration for system to a file 

toolbar button to save the configuration. 
6. Click Apply to create the selected configuration. The Volume display will close automatically and 

the Status window will refresh (within a minute or so) 

    
 
7. Partition the configured volume(s) to complete the implementation. See “Partitioning Volumes”  

for details. 
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This section describes how to use the Advanced Configuration Wizard to apply more than one 
storage policy to volumes on the SiI 4726 Storage Appliance. 
Why Advanced Configuration? 
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The Basic Configuration Wizard provides six predefined storage policies to quickly configure the SiI 
4726 Storage Appliance. Each predefined storage policy allocates the maximum system capacity to 
the selected storage policy. 
 
Using the Advanced Configuration Wizard, you can configure up to ten volumes - each with different 
storage policies and capacities. This flexibility provides numerous combinations of performance, 
redundancy, and capacity to meet your business requirements. For example: 
 

● For applications that produce critical data, redundancy is important.  You could use the 
Basic Configuration Wizard to implement the predefined SAFE, SAFE and FAST, or SAFE 
and BIG storage policy.  This format would allocate all hard disk drives to SAFE volumes.  
This may be excessive for your needs. Use the Advanced Configuration Wizard to create 
additional volumes and allocate capacity more efficiently 

● For applications that require hundreds of gigabytes of storage space, the added 
redundancy of a SAFE configuration’s Hot Spare may not be an acceptable luxury. Use the 
Advanced Configuration Wizard to create multiple volumes that make use of every 
gigabyte of available space. 

 
These are just a few of the possible combinations of storage policy and capacity allocations that you 
can create with the Advanced Configuration Wizard. Experiment with other combinations to allocate 
the total system capacity to meet your needs. 



 
 
Why Advanced Configuration? 
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1. The Advanced Configuration Wizard is an extension of Basic mode that allows you to create two 
volumes (virtual drives) on each physical hard disk drive. 
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Table 9 Sections of the Advanced Configuration Wizard 

Section Description 

Storage  
Policy 

Shows the available storage policies that you can assign to volumes. The 
options are enabled after you create a new volume or select an existing volume 
to edit. 

Volume 
List 

Shows Volume, Mode (storage policy), and Size details for currently configured 
volumes. Select a volume to edit or delete it. The Total Gb s Left field beneath 
the volume list shows the remaining capacity in gigabytes for all the hard disk 
drives. 

Drive 
Graph 

Displays disk space for each hard disk drive. All space allocated to the same 
volume appears in a matching color. A hatch pattern indicates a proposed 
configuration and a solid block indicates an existing volume. 

Advanced 
Controls 

Permit volume creation and modification on each hard disk drive:  
‧ Hot Spare check box indicates space on this drive is allocated as rebuild 

space for the selected SAFE volume. 
‧ ‘Use’ check box indicates drive membership within a volume. 
‧ Slider specifies capacity allocated to a volume. 
‧ Text field shows the capacity specified by manipulating the slider. 
‧ ‘Cap’ field shows maximum capacity for the hard disk drive. 
‧ ‘Vol#’ shows the virtual volume with which each hard disk drive is 

associated. 

 
Table 10 Toolbar Buttons on the Advanced Configuration Wizard 

Button Tooltip Description 

 
Read a configuration 
from a file 

Reads a saved configuration into the Advanced 
Configuration Wizard so you can apply the 
configuration to the SiI 4726 Storage Appliance. 
Available in Basic and Advanced modes. 

 
Write configuration for  
system to a file 

Saves a configuration to a file on the host computer. 
Available in Basic and Advanced modes. 

 
Restore configuration 
to last Commit 

Cancels proposed changes. Available in Basic and 
Advanced modes. 

 Create a new volume 
Creates a new volume on which to set the storage policy 
and capacity. You can create up to 2 volumes on each 
hard disk drive (10 total). 

 Edit selected volume Permits the storage policy and capacity of an existing 
volume to be modified. 

 Delete selected volume Deletes the volume that is currently selected in the 
volume list. 

 Delete all volumes Deletes all configured volumes. 

 

Copy configuration 
from other device in the 
system 

Copies the configuration of one SiI 4726 Storage 
Appliance to the current SiI 4726 Storage Appliance. 
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Table 11 Command Buttons on the Advanced Configuration Wizard 

Button Description 

To Basic Mode Opens the Basic Configuration Wizard 

When configuring a volume (create a new volume or edit a selected volume) 

Update Volume Applies the selected storage policy to a specific portion of a hard disk drive 
as a proposed configuration.  

Cancel Aborts the pending changes and returns the Wizard to the point where you 
can perform different advanced configuration functions. 

After configuring a volume 

Apply Submits configuration changes to the SiI 4726 Storage Appliance, closes 
the Wizard, and displays the updated configuration on the Status window. 

Cancel Aborts the in-progress changes and closes the Wizard. 
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Configure Multiple Volumes 

 
 
The Advanced Configuration Wizard allows many combinations of storage policies and capacities. 
This procedure shows how to modify a basic SAFE configuration so that it contains several volumes, 
each with different storage policies. This example illustrates one possible combination that allocates 
all of the system’s available capacity to: 
 

● One 50-gigabyte (GB) SAFE volume on drives 0 and 1, with no reserved space for a Hot 
Spare.  

● One FAST volume that uses the remaining capacity on drives 0 and 1. 
● One BIG volume that uses all of the capacity on drives 2, 3, and 4. 

 
The same sequence of steps applies to any configuration you choose to implement; only the storage 
policy and capacity allocation vary for different configuration options. 
 
Note: Before reconfiguring an existing SiI 4726 Storage Appliance with a new configuration, back- 
up the data. Use the Disk Management utility provided by your OS to delete all SiI 4726 partitions -  
except the unallocated, un-initialized disk that represents the SteelVine processor. Once the  
configuration and partitioning of the new volumes has taken place, it is safe to restore the backed- 
up data to the new configuration. See “Partitioning volumes” for details.  
 
 
1. Click the Configure Box toolbar button to open the Basic Configuration Wizard. 
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2. Click To Advanced Mode to open the Advanced Configuration Wizard. 
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3. Select the “Delete all volumes” from the toolbar. 

    
 
4. When prompted to confirm the deletion of the volumes, click Yes. 
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5. Select “Create a new volume” from the toolbar. 
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6. Select SAFE (RAID 1) as the Storage Policy.  Click on the “Use” check boxes underneath Drives 0 

and 1.  Move the slide to 50. 
 
Tip: Click to the right or left of the slider within the slider’s channel to make half-GB changes.  
  
 

 
 
7. Click Update Volume. 
 
8. When prompted whether to create a Hot Spare for the SAFE volume, click Number 

    
   In some configurations, the end-user may want the added redundancy of a Hot Spare. The goal of 

this example is to use all available system capacity to deliberately avoid the Hot Spare. 
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9. Click the Create a New Volume toolbar button. 
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10.  Select the FAST radio button in the Storage Policy section. 
11. Select the ‘Use’ check box beneath both Drive 0 and Drive 1. This example illustrates two-drive 

striping. 
12. Move the slider beneath Drive 0 all the way to the right to allocate the remaining capacity on the 

two drives to the Fast volume. If you wish, you can allocate less than the total remaining capacity 
to the new volume. However, doing so makes the unallocated capacity unavailable and unused. 

13. Click Update Volume. 
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14. Click the Create a New Volume toolbar button. 
15. Select the BIG radio button in the Storage Policy section. 
16. Select the ‘Use’ check box beneath Drive 2, Drive 3, and Drive 4 to allocate all of the remaining 

system capacity to the BIG volume. 
17. Click Update Volume. 

    
 
Note: Only the last Volume listed (in the above example, Volume 2) can be edited.  In order to edit 
Volume 1, Volume 2 must be deleted.  In order to edit Volume 0, all Volumes must be deleted and  
the end-user will need to start with a New Volume (refer to list item 9 - 13 for more details).  
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18. Click the Write Configuration for System to a File toolbar button to save the configuration. 

     
19. Click Update Volume to create the multi-volume configuration, close the Wizard, and display 

thevolumes in the Status window (within a minute or so). 

    
 
20. Partition the configured volumes to complete the implementation. See “Partitioning Volumes” for 

details. 
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Manage Configuration Files 

 
The Basic Configuration Wizard provides menus and icons to manage configuration files. 

● The Read Config File command from the File menu in the Basic Configuration Wizard 
imports a configuration file so that the end-user can restore a previously saved 
configuration (storage policy).                                                              

 
● The Save to Config File command from the File menu in the Basic Configuration Wizard 

exports an SiI 4726 configuration to a file. 
 
Each of the procedures in the “Basic Configuration” chapter prompts you to save a configuration file. 
 
Import a configuration file 
 
Note: The end-user must have previously saved a configuration file so that one is available to import 
it. See “Save a configuration file” for details.  
 
 
1. Select Configure Box from the Edit menu or click the Configure Box toolbar button in the Status 

window to open the Basic Configuration Wizard. 
2. Select Read Config File from the File menu in the Basic Configuration Wizard. 

    
 
3. Navigate to the required file and click Open to import it. The Basic Configuration Wizard provides 

notice of a successful import and graphically displays the imported volumes. 
4. Click OK to implement the imported configuration. 
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Save a configuration file 
1. Select Configure Box from the Edit menu or click the Configure Box toolbar button in the Status 

window to open the Basic Configuration Wizard. 
2. Select Save to Config File from the File menu in the Basic Configuration Wizard. 

    
 
3. Navigate to the appropriate directory, specify a file name in the File Name text box, and click the 

Save button. 
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This chapter explains how to partition volumes after configuring them with the SiI 4726 Manager. The 
end-user must partition volumes for the host computer’s operating system before one can store data 
on the volumes. Refer to the operating system documentation for further guidance. 
 
Why Advanced Configuration? 
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MS Windows 
 
Important: Before reconfiguring a volume, back up the data and delete previously defined SiI 4726 
partitions. Do not, however, delete the partition that represents the SteelVine processor (the “Not 
Initialized” disk with no capacity allocated to it). After the end-user configures and partitions the new  
volumes, S/he can restore the backed-up data to the new configuration. 
  
3. Right-click the My Computer icon and select Manage from the pop-up window. 
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2. From the Computer Management window select Disk Management under Storage to open 

Windows Disk Manager. 

     
 
Note: The Disk numbers in the Windows Disk Manager may be different from the Volume numbers 
shown in the SiI 4726 Manager Status window, the Basic Configuration Wizard, and the Advanced 
Configuration Wizard. Be sure to select the correct disk based on the expected disk capacity to create 
a partition. 
  
3. Right-click on the configured disk’s unallocated space and select New Partition. If the New 

Partition option is not available, select the disk and Initialize it first.  To do this, right-click on the 
disk item and select "Initialize Disk". 
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4. Click Next to start the Partition Wizard.     

    
  
5. Select the Primary or Extended option and click Next. 
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6. Specify the partition size. By default, the partition occupies the entire volume. Click Next.    

    
  
7. Assign a drive letter or mount path and click Next. 
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8. Select file system and name the partition and click Next.    

    
  
9. Review the file system settings and click Finish to create the logical partition.   

 
10. Repeat steps 1 through 9 to partition any remaining disks you configured in the SiI 4726 Manager. 

Remember, do not partition the disk that represents the SteelVine processor. 
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Mac OS X  
 
1. Launch Disk Utility from Application > Utilities folder.   

 
 
2. Select a configured disk and click the Partition tab. 

 
 
3. Select 1 Partition from the Volume Scheme drop-down list. 
4. Enter a name for the volume in the Name field. 
5. Select Mac OS Extended (journaled) from the Format drop-down list. 
6. Specify the size of the partition in the Size field.. 
7. Click the Partition button. 
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8. Click Partition to acknowledge the warning.    

    
Disk Utility mounts the created partition and represents it with an icon on the desktop. The icon is  
labeled with the partition name. 

 
9. Repeat steps 1 through 8 to partition any remaining disks you configured in the SiI 4726 Manager. 

Remember, do not partition the 320.0 KB Config Disk that represents the SteelVine processor. 



Administering the SiI 4726
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This chapter explains how to perform administrative functions in the SiI 4726 Manager. 
 
Change Password 

 
The SiI 4726 Manager limits configuration access with a password prompt. The password information 
is stored locally on the server running the daemon. The default password is admin. 

7 

 
1. Select Change Password from the File menu. 

    
 
2. Enter the current password (or use ‘admin’ if the default password has not been changed). 

    
 
3. Enter the new password of 5 or more characters in both fields. 

    
 
4. Click OK to implement the new password. 
 



 
Manage Client Connection to the Daemon 

 
The SiI 4726 Manager consists of two modules: 
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● Daemon                                                                            
 
● User interface 

The daemon monitors the status of SiI 4726 Storage Appliances and performs SAFE volume rebuilds. 
By default, the user interface attaches to a daemon running on the same host to display the 
information gathered by the daemon. The end-user can configure the user interface to display 
information tracked by a daemon running on a remote host. Having the user interface remote to the 
daemon allows remote monitoring for system fan and hard disk drive failures. Identification of a failed 
part will allow the service provider to replace failed components before further complications arise. 
 
Import a configuration file 
The end-user should have the following before a remote connection can be established: 

● The daemon is installed and running on a host computer connected to the SiI 4726 
Storage Appliance.                                                                          

 
● The user interface is installed and running on a remote host computer. 

 
● A TCP/IP connection can be established between the daemon and the user interface. The 

daemon listens for connections on TCP port 51115. Do not change this port number. 
Set up a remote connection 
 
1. In the Status window, select Change Connection from the File menu. 

    
 
2. Enter the hostname or IP address of the PC hosting the daemon. Click OK. 

    
    

The user interface will establish the requested connection and will display the information 
gathered by the remote daemon in the Status window. 



 
 
 
 
 
This SiI 4726 feature is provided to manage rebuilds of SAFE volumes. 
 
 
When is a rebuild necessary? 
 
A rebuild is initiated to restore data redundancy for a SAFE volume that has entered a vulnerable 
state. In a vulnerable state, one of the two mirrored disks goes offline or is inaccessible. Although the 
SAFE volume remains available during the rebuild process, the volume is susceptible to data loss 
through damage of the remaining disk until data redundancy is restored through a rebuild. Host 
access takes precedence over the rebuild process. If continuing to use the SAFE volume during the 
rebuild, the rebuild process will take a longer time to complete. 
 
Note: The rebuild feature also applies to other SAFE policies such as SAFE and BIG and SAFE and 
FAST. 
 
 

What happens during a rebuild? 

 
The rebuild process restores data redundancy by first utilizing space allocated for a Hot Spare. In 
case Hot Spare space does not exist or has already been rebuilt, the SteelVine processor rebuilds to 
empty space on a hard disk drive other than the one containing vulnerable data. Following a rebuild, it 
is not necessary to designate space to a Hot Spare for a subsequent rebuild to occur. 

 

Configure SAFE Volume
Rebuild Storage Policy 
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In this example, the daemon started a rebuild of Volume #1 after a failure of Disk #3. Once the 
end-user replaces Disk #3 with a new hard disk drive, the SteelVine processor will initiate a rebuild to 
Drive #3. 
 
Note: Once the daemon rebuilds to a designated Hot Spare, a designated Hot Spare will not exist and 
the SteelVine processor will rebuild to empty space. 
 
 
With Automatic Rebuild and Immediate Rebuild options selected, the daemon automatically initiates 
an immediate rebuild. If the end-user wants the daemon to delay the rebuild until after the first write to 
the SAFE volume, select the Rebuild Only If Needed option. The latter setup allows temporary 
removal of a hard disk drive without requiring a rebuild. To minimize the possibility of data loss, the 
rebuild process should be set up to start immediately. 
 
With Manual Rebuild selected, the end-user decides when to initiate rebuild following a rebuild 
prompt. Unless the SiI 4726 Manager is actively monitored, the Automatic rebuild should be set up to 
minimize the possibility of data loss. 
 
Note: In case the end-user selects No in response to a rebuild prompt, select Scan Devices from the 
File menu of the Status window to trigger a new prompt. 
Note: Once the daemon rebuilds to a designated Hot Spare, a designated Hot Spare will not exist 
 
 
 
Configure a rebuild 
 
1. Select Specify Policy from the Edit menu of the Status window. 
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2. Select one of the following policy options: 

● The Manual Rebuild radio button requires a user to manually initiate a rebuild of the 
volume.                                                                        

 
● The Automatic Rebuild option forces the daemon to initiate the rebuild process 

automatically and minimize the possibility of data loss. 

            
 
3. If the Automatic Rebuild option is selected, the end-user will have the following additional 

choices: 
● Immediate Rebuild causes the daemon to rebuild immediately following detection of an 

offline hard disk drive.                                                                      
 
● The Rebuild Only If Needed delays the rebuild for a SAFE volume with an offline hard disk 

drive until the write occurs to the SAFE volume. 
 
4. Click the Accept button to commit the selected options. 

     
 



Email Notification
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The Email Notification feature allows the end-user to have the SiI 4726 Manager send an email if any 
of the following conditions/situations occur: 
 

 Partition Rebuild Start 
 Partition Verify Start 
 Partition Rebuild Resume 
 System Fan Too Slow 
 No Boxes Found 
 Drive Unplugged 

 Partition Rebuild Complete 
 Partition Verify Complete 
 Temperature Too High 
 Power supply Fan Too Slow 
 Box Removed 
 Drive Inserted 

Each of the above conditions can be customized for sending options as well as the message that is 
sent. Below is an example of the Setup Email Notification screen. 
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Setting-up Email Notification 

 
1. The box available for the SMTP Server Name can be left blank. The SiI 4726 Manager will perform a 

DNS lookup and automatically find the correct address. 

    
 
2. The box available for the SMTP Server Port# uses Port 25 as a default. 

    
 
3. The From, To, and CC boxes are for specifying the intended receivers of the condition 

notifications. 

    
 
Note: In the From: box, the end-user should type in his/her own email address.  
  
4. Select ‘Test Email’ at the bottom of the screen to verify that you have correctly set-up the email 

portions of this feature. 
5. The Email Notification feature also allows the end-user to customize a message for each of the 

line items (of which each has its own default message already built in).  For instance, if the 
end-user wants to edit the message for ‘Drive Unplugged’… 

 
a. Click on the ‘Message’ box. 

     
 
b. The following will appear: 

     



45
 
 

c. The message information can be customized to suit the end-user’s needs. The Daemon can 
extract the following data from the SiI 4726 hardware: 

 
$B → 
$DS → 
$DN → 
$V → 

Box serial number 
Drive serial number 
Drive id [slot #] 
Current volume 

$T → 
$SF → 
$PSF → 

Current Temperature 
System Fan OK Flag 
Power Supply fan OK Flag 

 
d. If there is information that the end-user would like included in the error message, s/he can 

enter it themselves by typing in a selected message code listed above.  For instance: to put 
in the‘Box Serial Number’, type in the descriptive text followed by the message code as 
demonstrated below. 

     
 

 
e.  Click on ‘Accept’ to complete the change. 
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Why Advanced Configuration? 

 
 
When one of the conditions/situations occurs, a pop-up appears on the host computer stating that a 
email hasbeen sent. 

 
 
 
Note: The end-user must click ‘OK’ to remove the pop-up from the screen.  
  
 
The email received from the SiI 4726 will look like the following: 

       



 
Install New Firmware & 
Software 
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Firmware Update 
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Note: Do not power off or access the SiI 4726 Storage Appliance while upgrading firmware. 
 
1. Click the Specify Firmware toolbar button or select Specify Firmware from the Edit menu of the 

Status window. 

    
 
The Firmware Selection dialog shows all of the SiI 4726 Storage Appliances attached to the host, the  
integrated circuit (IC) revision, and the current firmware installed on each Storage Appliance. 
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2. Select the SiI 4726 Storage Appliance that requires a firmware upgrade. 
3. Click the Browse button next to the Update firmware from file text box, navigate to the new 

firmware file you wish to load from a CD or hard disk drive, and select the .bin file. 
4. Click Install Firmware to begin the upgrade. 
5. Click OK to dismiss a message box that states the firmware was successfully downloaded. 



 
 
Install New SiI 4726 Manager Software 

 
Before the end-user installs new software, the current version will need to be un-installed. The 
un-installation process stops the daemon so it can be removed along with the user interface. The new 
version of the daemon starts automatically when the new software has been installed. 
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Install the host controller card and driver 
 
MS Windows 
1. Exit the SiI 4726 Manager. 
2. Select Start > Control Panel > Add or Remove Programs from the Windows taskbar. 
3. Select the SiI 4726 Manager program and click Remove. 

    
4. Select the Remove radio button and click Next. 
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5. Click OK to confirm the complete removal of the SiI 4726 Manager. 

    
6. Click Finish to complete the un-installation process. 

    
7. Optionally, move or delete the .xml configuration files that the InstallShield Wizard left in the 

installation directory (by default, C:\Program Files\SteelVine\SiI 4726 Manager). 
 
MS Windows 
1. Optionally, move saved.xml configuration files from the Applications > Utilities > SteelVine > SiI 

4726 Manager Resources folder to another location. 
2. Drag the Applications > Utilities > SteelVine folder to the trash to remove the GUI modules and 

supporting files. 
3. Drag the Library>StartupItems>SteelVineDaemon folder to the trash to remove the daemon 

startup scripts. 
 
Uninstall Current Software 
See the Quick Install Guide for install instructions. 



Editing the UserConfig.xml 
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The UserConfig.xml file is used to define the Status Screen Title Bar and allow configuration of the 
Policy Change as well as the Advanced Configuration features. 
 
The UserConfig.xml file can be found in the following location:   
C:\Program Files\SiI4726\SiI 4726 Manager\SiI 4726 Config 
To edit this file, Right Click on the file name, move the mouse to Open With, and select Notepad. 
 

     
 
 
Once this file is open, the end-user will see the following: 
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The Email Notification feature allows the end-user to have the SiI 4726 Manager send an email if any 
of the following conditions/situations occur: 
 

 
<StatusScreenTitleBar> 

SiI 4726 Manager</StatusScreenTitleBar> 

 
<StatusScreenTitleBar> 

Your Company Name</StatusScreenTitleBar> 
 
The‘AllowPolicyChages’–True–turns on the Policy feature.  If the end-user changes the XML tag 
value to False, the Policy Icon will not appear in the GUI and the feature will not be available. 
 

 
<AllowPolicyChanges>True</AllowPolicyChanges> 

 
<AllowPolicyChanges>False</AllowPolicyChanges> 

 
The ‘AllowAdvancedConfig’–True–turns on the Advanced Config feature.  If the end-user changes 
the XML tag value to False, the general Configure feature will still be available, but the Advanced 
button (inside the Configuration feature) will not be available. 
 

 
<AllowAdvancedConfig>True</AllowAdvancedConfig> 

 
<AllowAdvancedConfig>False </AllowAdvancedConfig> 

 
 
Note: If the file is missing from the working directory, the GUI will allow both policy changes and 
advanced mode, as well as the status screen title to be set to “Sil4726”.  If there are any errors in the 
XML tag value, the Advanced Configuration button will not be available in the Configuration Setup. 
  
If there is an error in the XML tag value, a pop-up window will appear notifying the end-user of the 
error and the tag where it can be found. 

      



 
 
Creating a Splash Screen 
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The end-user can further customize the SiI 4726 Manager by creating a personalized splash screen. 
1. Create the logo for your splash screen – there are no image size limitations 
2. Save the logo as‘UserLogo.xpm’  

The .xpm file type is UNIX based 
3. Put the UserLogo.xpm file in the following location: 
    C:\Program Files\SiI4726\SiI 4726 Manager\SiI 4726 Config 
The splash screen will come up each time the end-user starts the SiI 4726 Manager.  It will stay up for 
2 seconds. 



Monitor and Troubleshooting  
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This chapter describes Status window color codes, LED indicator states, and event log messages 
that are used to troubleshoot the SiI 4726 Storage Appliance. 
 
Monitor the SiI 4726 Storage Appliance 
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Monitor drive status 
The color of the drives in the Status window indicates the status of the hard disk drives. 

    
 
Table 12 Drive Status 

Color State Description Resolution 

Green Normal Drive is active.  

Red Needs Rebuild
Drive is in a failed state. That is, a write has  
occurred to a SAFE volume while the disk 
drive was offline. 

 

Gray or 
Red Unplugged 

Drive is offline or unplugged. The 
background will appear red after a write to 
the volume. 

Verify the disk is  
securely in the bay. 
Otherwise, replace 
as necessary. 

Light 
Blue New drive New drive.  

Yellow Rebuilding Drive is being rebuilt.  

Purple Wrong slot 
There is a mismatch between the Serial # 
and Expected Serial # because a hard disk 
drive has been installed into the wrong bay. 

Install the correct 
disk drive into the 
bay. 
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Monitor temperature 
 
The SiI 4726 Storage Appliance uses the following colors to indicate temperature status. 
Table 13 Temperature Status 

Color Description Resolution 

Green Temperature is normal.  

Yellow Temperature is greater than 50? 
Celsius (122?Fahrenheit). 

Remove object(s) that interfere with airflow 
around the SiI 4726 Storage Appliance. 

Red Temperature is greater than 53? 
Celsius (127?Fahrenheit). 

Ensure constant airflow around the SiI 4726 
Storage Appliance. If there is no airflow, 
replace the fan. Identify the drive causing 
the temperature increase and replace it. 

 
 
Monitor fan status 
 
The SiI 4726 uses the following colors and values to indicate fan status. 
Table 14 Fan Status 

Color Value Description Resolution 

Green System + PS Both system and power supply fans are  
functioning within limits.  

Red System The system fan is not spinning or spinning  
slower than expected. 

Red PS The power supply fan is not spinning or  
spinning slower than expected. 

Red System + PS Both system and power supply fans are not  
spinning or spinning slower than expected. 

Contact point of sale 
for repair. 

 



 
Review Event Logs 

 
Event logs are helpful for troubleshooting and locating a system malfunction. 

56

1. Select Event Log from the Edit menu in the Status window.    

    
 
2. The Event Log screen displays a list of events in a tabular format. The Date column displays the 

date and time of the event.  The Box SN and Drive SN columns display the respective serial 
numbers for the event.  The Drive Manufacturer column displays vendor information. The 
Message column gives an event description. 

    
 
3. Click Refresh to update the log or click Close to close the log. 



 
Front Panel LED Indicators 

 
Each disk drive and the host connection have two LEDs to indicate drive status and/or host 
communication status. LED 0 is on the left and is typically blue; LED 1 is on the right and is typically 
green. In addition, there is one error-condition LEDs, labeled‘!’and the SiI 4726 power on 
indicator‘OK’. 
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When the SiI 4726 Storage Appliance is powered on, the host scans the disks in sequence, as 
indicated by a brief flash of lights on LED 1. Once the host scan is complete, LED 1 is lit for each drive 
present. During disk operations, LED 0 flashes as data is transferred to and from the drive and the 
host. 
 
If a SAFE volume is being rebuilt, LED 1 blinks slowly on both mirrored disks. 
Table 15 Status Indicators for 0 and 1 LEDs 

LED 0 LED 1 Description 

Off Off Power on, no device attached 

Off On PHY communication established (Activity = LED0 On) 

On Blink Rebuild 

Blink Blink Error 

 
Table 16 Status Indicators for ! and OK LEDs 

! OK Description 

Off On Startup or ON indication. OK LED will flash during reset and 
will remain green in all other cases. 

On  ERROR. The‘!’LED will light as a result of an EEPROM error during 
boot or following a runtime error. 

 



Troubleshooting 
 

Problem Resolution 

LEDs 

Green“OK”LED does not light. Confirm power at the outlet, verify power connection, and try 
an alternate power cable. 

Red“!”LED is lit. Power cycle the SiI 4726 Storage Appliance and to reload the 
firmware. 

SiI 4726 HOST LED 1 is not lit. See HBA connection below. 

LED 1 continuously flashes for  
one or more drives. 

LED1 flashes during a Safe volume rebuild. If the LED flashes 
while the SiI 4726 Storage Appliance is not rebuilding, verify 
the eSATA connection and try an alternate eSATA cable. 

LED 1 remains off for one or  
more drives. 

Swap drives to ensure that this is not a drive bay or LED 
problem. If the LED off state is specific to a drive, evaluate the 
drive for failure. 

Fan 
Rear fan is not running. 
Power supply fan is not 
spinning. 

Confirm the outlet is powered, verify power connections, and 
try an alternate power cable. 

HBA connection 
Verify the OK LED status to confirm power. 
Verify the eSATA connection and try an alternate eSATA cable. 
Verify HBA BIOS recognizes an empty SiI 4726 Storage Appliance.
Turn off PCI bus power save mode in the host BIOS. SiI4726 Storage Appliance is 

not  
recognized by HBA BIOS. Troubleshoot the HBA: 

 Connect to an alternate SATA port. 
 Connect an alternate device to the HBA. 
 Remove all other PCI peripherals to rule out interference. 
 Move the HBA to an alternate PCI-X slot. 
 Try the HBA in a PCI slot. 

Verify HBA BIOS recognizes an empty SiI 4726 Storage Appliance.
Before deleting or altering volumes with the Configuration 
Wizard, delete partitions residing on the volume. To delete 
partitions, use the operating system’s Disk Manager. 
Ensure the HBA driver is current.The SV-HBA3124 driver is 
available at www.steelvine.com 
Troubleshoot driver: 

 Verify driver active status. For Windows, Device Manager 
should show the SCSI icon next to the HBA. For Mac OS X, 
Disk Utility should show a SCSI Connection ID for the virtual 
disks on the physical drives. Error messages during the 
driver installation would have indicated issues. 

 Resolve resource conflicts (IRQ, DMA, or I/O). 
Identify maximum SATA disk drive capacity supported by the 
operating system and ensure the volume size meets the limits. 

Operating system does not  
recognize one or more of the 
SiI 4726 volumes. 

Verify port multiplier support in the HBA. 
Review SiI 4726 Release Notes available at www.steelvine.com for additional troubleshooting information.

58

 



 

 



 
 

 



 

   


	Manual.pdf
	BT-3045.pdf
	BT-3045.pdf
	3045.pdf
	1.pdf
	2.pdf
	3.pdf

	P1.pdf
	P2.pdf
	P3.pdf
	P4.pdf
	P5.pdf
	P6.pdf
	P7.pdf
	P8.pdf
	P9.pdf
	P10.pdf

	P11.pdf
	P12.pdf
	P13.pdf
	P14.pdf
	P15.pdf
	P16.pdf
	P17.pdf
	P18.pdf
	P19.pdf
	P20.pdf
	P21.pdf
	P22.pdf
	P23.pdf
	P24.pdf
	P25.pdf
	P26.pdf
	P27.pdf
	P28.pdf
	P29.pdf
	P30.pdf
	P31.pdf
	P32.pdf
	P33.pdf
	P34.pdf
	P35.pdf
	P36.pdf
	P37.pdf
	P38.pdf
	P39.pdf
	P40.pdf
	P41.pdf
	P42.pdf
	P43.pdf
	P44.pdf
	P45.pdf
	P46.pdf
	P47.pdf
	P48.pdf
	P49.pdf
	P50.pdf
	P51.pdf
	P52.pdf
	P53.pdf
	P54.pdf
	P55.pdf
	P56.pdf
	P57.pdf
	P58.pdf

	P59.pdf
	P60.pdf
	P61.pdf

